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What's New in Autodesk Inventor 2018

Inventor 2018 is built for the continually evolving needs of the modern design and engineering professional.

Building on its breadth of modeling capabilities and powerful design automation tools, Inventor 2018 marks
the next step forward in professional-grade 3D mechanical engineering design. Interoperability enhancements
enable distributed, multi-disciplinary teams to work together more efficiently with data from a variety of
sources. The overall user experience is enhanced for more productivity and flexibility in response to direct
feedback from customers around the world.

These efforts let you design, engineer and collaborate faster and more effectively than ever before.

PROFESSIONAL-GRADE DESIGN
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Professional-Grade Design

Engineers constantly need to drive innovation in their design work for better products and more efficient
processes. To stay ahead, you need ever faster, more powerful tools that help you realize better performance
and productivity. Inventor 2018 delivers just that.

Improvements have been made in several core functionalities you use every day. Projecting geometry in
sketching, multi-body sheet metal parts and part modeling workflows have all been enhanced. Inventor 2018
delivers key performance improvements to large assembly and drawing workflows. And integrated Model
Based Definition has been added to give you the ability to add Geometric Dimensioning and Tolerencing and
3D Annotations to your models to streamline documentation and enable downstream use of your 3D designs
for manufacturing and quality processes.

Model-based definition

Model-Based Definition (MBD), is a powerful new set of tools for adding annotations, GD&T, and other
manufacturing information directly to a 3D part. The integrated Tolerance Advisor checks the health of your
tolerance scheme and lists potential problems, errors, and other information in the Tolerance Advisor
browser. Once your 3D model has MBD and 3D Annotations applied you can recover in your 2D drawing,
exportin a 3D PDF or STEP AP242.
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Tip: Go to the Get Started tab > Tutorial Gallery and download the GD&T guided tutorial to get familiar with
the new commands.
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Sheet Metal

Multibody sheet metal parts now support unique rules and thickness for each body. Multi-body rules can be
applied to bodies in the browser, or while creating new bodies within the Face, Contour Flange, Contour Roll,
and Lofted Flange dialog.

Set Sheet Metal Rule *

[ ] Follow Defaults
Sheet Metal Rule

16 GA 55T e /
14 GA 55T |
18 GA 55T el
Default I

| Default_mm

Tip: The Sheet Metal 3 v2 guided tutorial includes the new unique thickness workflow.
Performance

All documents benefit to some degree, but the most noticeable improvements are seen when working with
large assemblies and large assembly drawings. For example:

You will experience faster...
e Hidden line removed view display

e View navigation - pan, zoom, and orbit
e Drawing view creation, preview, and edit
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Drawing Improvements

After selecting an assembly document to place in a drawing, if the preview can display in under 3 seconds it
will do so. If it takes longer a Preview progress dialog box displays. The dialog box is the only element you can

interact with during its display.
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From the Open dialog box you can:

e Defer drawings
e  Turn off model preview
e Recover mesh bodies, surface bodies, and all model dimensions
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EXPANDED INTEROPERABILITY

Shembwrap
AnyCAD
I STEP
AUTODESK'
INVENTOR'
- & o5 CATIA

Q Simplification £ BIM Content

Meshin Drawings [°"""! { Y

Expanded Interoperability

Inventor 2018 delivers new capabilities for mechanical engineers who work with a variety of design data. You
can continue to use imported mesh data in your designs, and also leverage STL or OBJ files in your Inventor 2D
drawings. Surface data can be combined with your other 3D data in the Presentation environment for
animations, exploded views, and documentation. In addition to outside data, Inventor 2018 helps you work
with other Autodesk file formats. BIM Content workflows allow for direct publishing of Revit (.rfa) files. DWG
Underlay has been improved to streamline workflows when integrating your 2D data inside of 3D designs.
With the release of Inventor 2017.4, AnyCAD is enhanced to allow Inventor 2018 to be compatible with
Inventor 2017.

Mesh
Support for displaying and documenting mesh objects is added to drawing views. Mesh objects participate in
all view types and can be dimensioned and annotated.

Compenent | Model State | Diplay Opsiors | Recovery Opsors
Models of Mxed Body Types
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Shrinkwrap and Shrinkwrap Substitutes

Shrinkwrap tools have been enhanced for more control, improved user interface, and an improved workflow.
You can leverage View and LOD representations to quickly define lightweight models.

Shrinkwrap
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BIM Content

BIM Content has been enhanced for simplification, authoring, and publish workflows. Inventor 2018 lets you
publish directly to IFC and Revit (.rfa) file formats.

AUTODESK AUTODESK’
INVENTOR® REVIT
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AnyCAD (not available in Inventor LT)

With Inventor 2018, AnyCAD has been expanded to allow you to leverage Inventor 2018 files in your Inventor
2017 designs. This means you can now work with others who are on versions of Inventor that are earlier or
later than the version you are working in. To help you identify the version of an Inventor file, the Open dialog
now displays Inventor version a file was last saved in.
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Starting with Inventor 2017.4, you can reference future (newer) versions of Inventor part and assembly files in
an earlier version of Inventor. For example, with Inventor 2017.4 you can reference an Inventor 2018 part file
in Inventor 2017.
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Inventor 2018 continues to enhance your core AnyCAD workflows by more robust support of new features
you add to non-native Inventor files. After the source file is updated, your Inventor based features will be
preserved.

File updated in native software

DWG Underlay

New DWG Underlay features make working with DWGs faster.

° Import your DWG file directly into an assembly using the Place Components command.

° Select multiple DWG Files when creating more than one underlay.

. Open an AutoCAD DWG file directly from the right-click context menu in your part or assembly model
browser node in Inventor.

. Automatically project certain types of DWG geometry when you enable the new Application Options >
Sketch > Autoproject edges during curve creation option.

° If the selected DWG Underlay geometry is within the XY, YZ, or XZ plane, the resulting joint is created on
the same plane as the sketch in the same way a joint is created between 2D Inventor geometry.

° Create a joint on the same plane as the sketch in the same way a joint is created between 2D Inventor

geometry: If the selected DWG Underlay geometry is within the XY, YZ, or XZ plane, the resulting joint is
created on the same plane as the sketch.

Legacy Inventor Inventor 2018
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Presentations

The Presentation environment in Inventor 2018 now allows for support of surface data. Your surface files can
be included in:

e Window selection
e Component tweaks
e Use surfaces to orient the tweak triad

Added in 2017R2: Multiple edit actions have been added to the timeline to allow for Group, All Before, All
After selections. You can also create a new Presentation file directly from the browser of an open assembly.
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THE INVENTOR EXPERIENCE

I INVENTOR IDEAS

Measure § Browser Panels

User Driven Productivity

The Inventor Experience

Inventor 2018 continues to focus on customer Inventor Ideas requests, feedback and giving you a delightful
experience inside of Inventor. Customer-driven enhancements throughout Inventor 2018 improve core
workflows and model interaction. Commands like Chamfer, Assembly Interference Analysis, Extrude and Hole
have added options based on your direct feedback. In addition, both the Browser and Measure have been
refreshed to deliver a more feature rich experience for all Inventor users.

The following enhancements were all implemented directly from your feedback posted on Inventor® Ideas.

New and Improved Measure Workflows and Graphics
The Inventor measure tools and workflows have been greatly simplified and improved to enhance
productivity. You can now:

Use a single measure command!

Perform all measure workflows from the new measure tool panel.

Display rich information for each selection with a single click.

Easily measure angles and identify measure selections in the graphics window.
Easily identify measure selections in the graphics window.

Additional productivity enhancements.


http://forums.autodesk.com/t5/inventor-ideas/idb-p/v1232/tab/most-recent
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Browser Tools

Save time with the exciting new browser tools.
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Find things quickly and easily in the current active document with the new browser search.

In an assembly file, use the filter tools ¥ tonarrow your search (not available in Inventor LT).
Move and dock each tab to your preferred way of working. The following image is an example of side-

by-side docking.
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Assembly Open
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Designed by Mastenbroek using Inventor

e Quickly open Full or Express from the dialog box drop-down list.
e Find command is moved to the lower section of the dialog box.

Part Creation
e Extrude: Use the new Distance from Face option in the Extrude dialog box to start an extrusion from a

face or workplane with a distance. Because Distance from Face creates one central entry point for modifying
the geometry, no additional steps to make sketches or workplanes are needed.
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e Chamfer: Youcan now create a chamfer that does not require an entire edge. A new tab, Partial, is added
to the Chamfer dialog box to support the creation of partial chamfers.

e Hole:

o) You can now create a symmetric hole type that extrudes in two directions. The Flip Termination
button is replaced with Directionl and Direction 2 buttons. The Symmetric distance is only
available for the Drilled - Simple Hole - Through All hole type.

o You can now specify zero (0) as a value for bore depth on Spotface holes. As a result, you can
now place a spotface hole on the termination face of a body.

o) Use the new option, Extend Start, on the Hole dialog box to extend the start face of a hole to the

first place where there is no intersection with the target body. The purpose of Extend Start is to
remove a fragment resulting from the creation of the hole.
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Drawings

e Export to PDF:

1 Save As

7 Autodesk A360 Savein:| |, Drawings vi@F e @

(] Workspace - -

€ Frequently Used Subfolders Name Date modified Type Si
(] Assemblies )\ OldVersions 4S2016812AM  File folder

G)

o The From and To values specified for Sheets in range are no longer session based.
o The new option, Display Published File in Viewer, when selected, displays the sheets in Adobe Acrobat
Reader after clicking Save.

e Text Border Option: Add a text border around text and leader text.
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www.irinventor.com st gl S gl ) B a i eanadi 355l aa e Email: irinventor@hotmail.com

Parameters

The Parameter dialog box is enhanced to include a Consumed by column and By Features filter.
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e By Features filter
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General

Productivity and Performance Enhancements
Productivity Improvements

e Easier access to Express mode Open for assemblies.

e In drawing views, a delay has been added to the view update when you are editing the scale. The delay
allows you to enter the new scale without the view reacting to each number entered.

e You can exclude surfaces from drawing views. In the Drawing View dialog box, on the Recovery Options tab,
clear the checkbox on Include Surface Bodies.

e Inadeferred drawing, you can access Defer Updates from the context menu. The behavior is the same as if
you were accessing the option from Document Settings.

e You can change the view preview option from the Open dialog. Clear the check on the eyeglasses and the
preview is a bounding box.

‘ 0.03:1 - ‘

@ peo

e Browser state icon for out of date components. Views with out of date components also get the state icon.
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Parameters

e A Consumed by column is added to the parameters table to make it easy to identify where a parameter is
used.
e By Features is added to the parameter filter options.

@ Features
All

= Key

Mon-Key
Renamed
Equation

v By Features

Tip: In a part with multiple bodies, use Consumed by with the By Features filter option to identify
dependencies.

Model

£ CashCan.ipt
o 4P Folded Model Parameter Name Consumed by
o 5 solid Bodies(2) » -HSheet Metal Parameters:22 GA ST
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Performance Improvements

All documents benefit to some degree, but the most noticeable improvements are seen when working with
large assemblies and large assembly drawings.

Faster view compute for hidden line removed views such as: shaded, section, and detail.

Zoom in and zoom out and the related methods of input, such as a mouse, keyboard, 3D mouse, ViewCube,
Navigation Bar, and Ribbon commands now use the minimum frame rate setting.

Faster Move, Pan, and Rotate views in models and drawings.

Assembly Open - particularly for nested file structure.

Drawing view creation, preview, edit view, and change view representation.

Faster 2D graphics rendering including sketch, drawing view, and DWG Underlay.

Faster component selection in drawings.

Faster raster view rendering.

Faster selection and highlight in both express and full mode.

The performance improvements make some application options and document settings obsolete. The
following have been removed:

Application Options

General tab - In the Tooltip Appearance section, Show ToolClips

File tab - In the File Open section, Enable Quick File Open

Drawing tab - In the Capacity/Performance section, Memory Saving Mode
Assembly tab - Enable related relationship failure analysis

Document Settings

Drawing tab - Memory Saving Mode
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Browser Enhancements

Save time with the exciting new browser tools.

Search

e Find things quickly and easily in the current active document with the new browser search.
o File nodes, both collapsed and expanded.
o iProperties: An icon displays next to search results with matching iProperty fields. Hover over the
icon to display the information.
o Relationships (not available in Inventor LT).
o Features.

e Click ] to display the search field. The quick search field searches as you type.

Model = &4
Type Keyword

I
o |

e Inan assembly file, use the filter tools 2 ¥ to narrow your search (not available in Inventor LT).

o Clear the filter.
o Filter out unresolved files.
o Filter out out-of-date files.

Additional Browser Enhancements
e The Model panel displays by default. Select to select to display a browser panel. Click the x to remove

a panel.
e Each tab can be moved and docked. Below is an example side by side docking.

Il

tﬂ chamfer2.ipt Rules Fnrms| Global Fnrms| E{ita ok
» EE: Solid Bodies{1) @ chamferZ.ipt
b T_';- Views: Master &, width_Rule
. ®, Hole
3 -[] origin &, Message
b m Extrusionl
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New Browser menus: Select B to access display options and Help:

Model = [ [o—

(1) chamfer2.ipt Expand All

> £ solid Bodies(1) Collapse All

3 T3 View: Master i Find... Ctrl+F

> [ origin Hide UCS

> (P estrusiont Help Hide Wark Features
@ Holex Hide Notes
(3 Fillett Hide Documents
(3 Filletz Hide Wamnings
(3 Fillet3 Show Extended Names
O End of Fart

In an assembly and presentation file, you can select the new browser menu option, Edit Values in Browser,
to enable or disable the browser edit box (not available in Inventor LT).

=
Expand All
Collapse All
{if} Find... Ctrl+F
[# Edit Values in Browser
Display Preferences L
Help

The browser edit box displays when selecting a constraint in an assembly browser or a tweak in a
presentation browser. The edit box now displays near the selected item instead of at the bottom of the
browser.

% Arbor_Press.iam
[ Relationships

= gitate: 1
m Insert: m ¥
,E:-}' Mate:3

You can now easily switch between model, assembly, and other environment browsers with a single click.
For example, when the Inventor Studio environment is active, you can now simply click to switch between
the Inventor Studio browser and the Modeling browser.

Model x [Kg Q =
Modeling | Inventor Studio

@ chamfer2.ipt
- [ Productions
3 &, Animations
Lighting
i |j@ll Cameras
-~ ¢ Animation Favorites

y Local Lights
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Measure Enhancements

New and Improved Measure Workflows and Graphics

The Inventor measure tools and workflows have been greatly simplified and improved to be more user
friendly and intuitive.

e One measure command.

e Perform all measure workflows from the new measure tool panel.

e Each selection displays rich information with a single click in the measure tool panel.
e Simplified angle measuring.

e Easily identify measure selections in the graphics window.

e Additional productivity enhancements.

One Measure Command

Access all measure workflows from a single Measure command on the Tools tab on the ribbon in the part and
assembly environments.

2018 2017
—  — '[_3_ Angle
) [ asasaca]
Loo
Measure Distance é]‘ P
Eﬁ Area

Measure - Measure -
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One Tool Panel for Measure

e Set Dual Unit and Precision Values. When one or more User Coordinate Systems (UCS) are defined in a file,
you can specify the coordinate system to use.

Advanced Settings L
Coordinate Sys! Origin

Precision 3123

Angle Precision 212

Dual Units Millimeter ~

e View precision and units for all length, area, and angle values. Each selection displays rich information with
a single click. For example, select a cylindrical face: The diameter, area, and total loop length display. Results
update if you change a dual unit or precision value.

e s
Measure xX |Kg =

Selection 1 (Face) v [%
Radius 0.125in 3.175 mm =
Diameter 0.250in 6.350 mm

Total Loop Length 1.571in 39.898 mm

Area 0.506 in? 326.505 mm?

Advanced Settings

e Switch the selection priority between Component, Part, and Faces and Edges in assemblies (not available in
Inventor LT).

[

e Copy one or all values to the clipboard.

Measure Results o |a
Center Distance P ———| =
Delta Copy Ctrl+C

Minimum Distan Copy All Ctrl+Shift+C
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Simplified Angle Measuring
Use one of the following methods to measure an angle:
e Select a line or axis and then select a planar faces.

e Select an arcor circle.
e Select 2 points, and then hold down SHIFT and select the third point of the angle.

1. Select the first 2. Select the next 3. Press and hold SHIFT and select
point of the angle to point of the angle to the third point of the triangle.
measure in the measure in the

graphics windo. graphics window.

=,

Measure Results

Angle 91.85 deg 1.60 rad

~ Delta

X Distance 2.952in 2.952in
Y Distance 1.359in 1.359in
Z Distance 2114in 2114in

Selection 1 (Vertex)

Easily Identify Measure Selections in the Graphics Window

o The geometry you select to measure remains highlighted in the graphics window.

e C(Clearly distinguish between the first and second selection: The Measure selection set 1 and selection set 2
display different colors in the graphics window so that you can identify the information for each selection
in the Measure tool panel. You can change the color of the highlighted selections using Application Options
> Colors tab by selecting a color scheme from the Color Scheme list.

Advanoed Settings

Precision
Angle Precision 212 W
Dual Units
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Additional Measure Productivity Enhancements

Minimum Distance, Center to Center Distance, and Maximum Distance

Minimum Distance and Center to Center distance now display at the same time when at least one of the
following types of geometry are selected.

e Arc/Circle

e Ellipse

e Cylinder/Cone/Torus
e Sphere

Maximum Distance also displays when 2 of the following types of geometry, on the same plane, are selected:
Vertex, line, arc and circle.

Easily toggle between Minimum Distance, Center to Center Distance, and Maximum Distance for the distance
delta value.

Center Distance Minimum Distance Maximum Distance
y.ﬁ"

x K = Measure x [od =

kg

Measure Results oo

Senter Distance L0001 Center Distance 1.000 in Center Distance 1.000in
Delt

elta Delta Delta
Minimum Distance  0.8121n

Delta

Minimum Distance 0.812in

Minimum Distance 0.812in
Delta

Delta
Maximum Distance 1.188in
Delta

Maximum Distance 1188in
Delta Maximum Distance 1.188in

Deita

Selection 1 (Edge] hd
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Sorting Enhancements

New Sort Option

Use the new options on the Sorts Parts List and Bill of Materials Sorts dialog box to control the sort behavior.
You can specify whether to sort by numerical order or by a leading digit (string).

Sort Parts List [

Sort by
|nune =1 Ascending
Descending
Then by
none - Ascending
Descending
Then by
none - Ascending
Descending
|| Auto Sort on Update
icdl oK Cancel
Sort numerically
‘@) Sort by string
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General Enhancements

Inventor Connected Design No Longer Loads by Default
(not available in Inventor LT)

Connected Design on A360 functionality is no longer loaded by default when you open a part or assembly file.
You must load Inventor Connect Design add-in using the Add-in Manager. Once loaded, the Connected Design

entry button 3 displays in a part or assembly file in the bottom right corner of the graphics window.

Mini-toolbars No Longer Display by Default

The min-toolbars that display alongside of the 7 Inventor dialog boxes, Extrude, Revolve, Fillet, Shell, Face
Draft, Chamfer, and Joint, no longer display by default. You can elect to display or hide the mini-toolbars. To
set your preference: On the ribbon, View panel > User Interface panel Mini-toolbar.

Extrude 2
Shape | More
Extents

L | Profile
— ! Distance -

Solids

3 (=]
Output E “25 ;5 k‘kﬂ

10 mm b

als i

v &’ oK Cancel

A
H'P 10 mm 4
1 7 Profile | »
WM WS
o | X (B

Apply Button Added to Trim Surface Dialog Box

An Apply button is added to the Trim Surface dialog box so that you can continue to trim without exiting the
command.
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Parts

Model-Based Definition

Model-Based Definition (MBD), is a powerful new set of tools for adding annotations, GD&T, and other

manufacturing information directly to a 3D part.
Tip: Be sure to check out the guided tutorial in the gallery to help you get started using the new commands.

3D Annotation

To access the 3D annotation commands, use the new Annotate tab in a part file and add the manufacturing
information directly to the 3D model.

File 3D Model  Sketch [EEUNSICICE Inspect Tools Manage View  Environments  Get Started  Add-Ins  Autodesk A360

TR

. o Quarter Section View ~

Tolerance DRF Tolerance Dimension Hole/Thread Surface Leader General  General 3D PDF CAD Format
Feature Advisor Note Texture Te]}g MNote Profile Note
Geometric Annotation General Annotation Notes Manage Export

Use the Tolerance Feature command to attach GD&T annotations, Feature Control Frames, and Datum
Identifiers to part faces or features. Enable the Tolerance Advisor browser to check the health of your
tolerance scheme and display information such as the following:

e List of potentially problematic datums and Datum Reference Frames (DRF's).

e Information about which features are not fully controlled.

e Errorsin atolerance feature.

Tip: Right-click an entry and select More Information to open a help page specific to the message.

Tolerance Advisor
() Le-0oL.ipt
i@ One or more surfaces are unconstrained
[=-£7 Planar Surface 2
| LA Location not fully constrained
5 D
A\ DRF specification is incomplete
(@ DRF is not referenced

Use the General Annotation and Text commands to fully document your model.
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i
2

3D annotations and view representations are displayed when you create a 3D PDF file.

Retrieve Annotations in Drawings

A new 3D Annotations tab in the retrieve dialog box lets you recover the MBD information from a part and use
it in a drawing. Use the Design View and filter options to see the information you want.

| Sketch and Feature Dimensions|

Design View
(Top

Annotation Filters

Vi Vi 68

2N Vv~

Export MBD

Step AP 242 support is added. You can now export a fully annotated 3D model that can be used in
downstream manufacturing operations. You can also attach a STEP file when you export a 3D PDF.

V] View POF when finished . 1 STEP File Save As Optio

Attachments Application Protocol
© 203 - Configuration Controlled Design
) 214 - Automotive Design
[ Attachments... | © 242 - Managed Model Based 3D Engineering

[¥] Generate and attach STEP file | Options... g
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Sheet Metal Updates

Previously, multibody sheet metal parts were required to share a single thickness. The rules now let you
define a unique thickness for each body.

Support Multiple Thickness and Rules

The following commands are enhanced to support unique thickness and rules:
e Face

e Contour Flange

e Lofted Flange

e Contour Roll

In the create dialog box, clear the Follow Defaults checkbox and then click the drop-list to specify a unique
material thickness and rules from the predefined list. When you select Follow Defaults, the thickness and rules

are determined by the active standard.
Sheet Metal Rule

[¥] Follow Defaults

Default -

When you mouse over a solid body in the browser, a tooltip displays the active rule for the body.

£§) CashCan.ipt
v @ Folded Model

v Solid Bodies(2)
K

‘U 16GassT

> T
You can right-click a solid body in the browser and select the new Set Sheet Metal Rule context menu
command to modify the rules and body thickness.

Model %
44 CashCan.ipt

v Folded Model
: Set Sheet Metal Rul ‘ ﬂ
v E’:i Solid Bodies(2) LB i

Encl
q elosure DFal\ow Defaults
- L . Sheet Metal Rule
1= View: Master
> origin [2zcasst -]

> P contourFinget. [ e e —
> Hn\el Default
@Work Planel Default_mm

P Contour Flange2
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Extrude Enhancements

Eliminate Steps with Distance from Face

Save time with the new extents option Distance from Face. Use Distance from Face in the Extrude dialog box
to start an extrusion from a face or workplane with a distance. Distance from Face creates a copy of the
selected face along the extruded direction. Additionally, modifying the geometry becomes easier. Because
Distance from Face creates one central entry point for modifying the geometry, no additional steps to make
sketches or workplanes are needed.

Extents

Distance
To Next

To
Between
All

This workflow can be especially useful in conjunction with Skeletal Modeling, (a type of Top-down Design)
techniques that facilitates centralized design criteria and creates components that reference those criteria.

e Select a sketch profile, and then select a face, work plane, or surface to start the extrusion from. The sketch
profile is selected automatically if there is only one.
e Specify the direction and distance.

The new Select to terminate feature by extending the face option terminates the extrusion on a face that
extends beyond the termination plane.

Extents

Distance from Face

%] b .
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Use the More Tab Options on the Extrude Dialog Box for Different Results

With Distance From Face and Direction 1 or Direction 2 selected on the Shape tab, use the options on the
More tab to get different results.

Direction 1

More

Profile [E/ |?Sj;:2&from Face ¥
Solids E N ] L
Output E 3.5 N

@lel (o) @l

Direction 1, Alternate Solution direction 1, and Minimum Solution selected

Shape | More r

Alternate Solution \
@@ [ Minimum Solution \\/

Direction 1 and Alternate Solution direction 1

Alternate Solution

@@ D Minimum Solution

=
p
Shape | More i %
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Direction 1 and Alternate Solution direction 2

Shape | More ||

Alternate Solution

@@ [ | Minimum Selution

Direction 1, Alternate Solution direction 2, and Minimum solution selected

- T

Shape | More |I

Alternate Solution

@@ Minimum Solution

Direction 2

Shape || More |

Extents

Profile ’Distancefrum Face v]
OPFEE

Qutput 7.5 b

ale] & [ =

& Solids

Y EI

Direction 2, Alternate Solution direction 1, and Minimum Solution selected

Shape | More

Alternate Solution

¥ @ [¥] Minimum Solution
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Direction 2, and Alternate Solution direction 1

Shape Maore

Alternate Solution

E Minimum Solution

Direction 2, Alternate Solution direction 2, and Minimum Solution selected

Shape | More

Alternate Solution

E |E| Minimum Solution

Direction 2 and Alternate Solution direction 2

Shape Maore

Alternate Solution

E E Minimum Solution
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Hole Enhancements

New Hole Settings Provide a Robust Way to Create Bi-Direction Holes
You can now create a symmetric hole type that extrudes in two directions.

The Flip Termination button is replaced with Direction1 and Direction 2 buttons. The Symmetric distance is
only available for the Drilled - Simple Hole - Through All hole type.

Legacy Inventor Inventor 2018

Termination

Termination
Through All -
Through All - @ @

Termination

Termination
& (%)
istance -

Spotface Holes Enhancement

In a part file, you can now specify zero (0) as a value for bore depth on Spotface holes. As a result, you can
now place a spotface hole on the termination face of a body.

Legacy Inventor Inventor 2018

i | 0.750 in [ 3 . | 0.750 in 3
™ M| E I

0 3 0in 3
|
I“'@
-

_ I

oW

) § N

oW o §i
|<—n.25in P

1 bk
W7 ;
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Hole Creation Enhancement

Use the new option, Extend Start, on the Hole dialog box to extend the start face of a hole to the first place
where there is no intersection with the target body.

The purpose of Extend Start is to remove a fragment resulting from the creation of the hole. If the result is not

desired, deselect Extend Start to undue the result.
Extend Start does not remove the fragment resulting from the creation of the hole on multiple bodies.

Termination
[Di,stance Y] @ E?j
|| Extend Start

Extend Start is only available in the part environment.

Legacy Inventor Inventor 2018 with Extend Start selected
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Chamfer Enhancements
Support for Partial Chamfers

You can now create a chamfer that does not require an entire edge. A new tab, Partial, is added to the
Chamfer dialog box to support the creation of partial chamfers.

The settings on the Partial tab allow you to terminate a chamfer at a specific distance along an edge. You
create a partial chamfer by defining the location of end vertexes along an existing chamfer edge, and the start
vertex is created automatically.

After clicking a point on an edge to define the end point, you can change the driven dimension type to To End
(distance from end of edge to end of chamfer), To Start (distance from start of edge to start of chamfer), or
Chamfer (chamfer length), using the new Set Driven Dimension drop-menu. The default driven dimension type
is To End. 3 parameters are created, one of which is a reference parameter based on the selected driven
dimension setting.




www.irinventor.com D5 s S gl I3 a8 (anadd LG54l aa e Email: irinventor@hotmail.com

iLogic Enhancements

New iLogic Security Alert Feature Helps Keep you Safe

A security alert displays when you run a rule Inventor detects to be potentially unsafe. You can choose to run
the rule as safe or not run the rule. If you select Run the rule the iLogic Security Advisor displays where you
can access the iLogic Security dialog box for additional options for managing unknown code.

-i’} Security Alert

iLogic has disabled a potentially harmful rule. ("Rule0” in file "Cylinder
Base.ipt”)

If you trust the contents of this rule and would like to enable it on your
machine, click Run the rule.

< Don't run the rule
This is the safe option; choose this if you are unsure.

< Run the rule
Enable this content if you trust it.
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Assemblies

Assembly Open Enhancements

For Assembly Documents and Place Components

The following changes occur in the lower section of the File Open dialog box:

-

Files of type: l.ﬂu_rtudesk Inventor Files (iam;”.dwag;™idw;”j "]

ProjectFile:  |D - 2018 Early.ipj

Last Saved: Autodesk Inventor2017 (21.0.18500.0000)

ey | | (R ‘Full "'[ Options... ] [ Open ” Cancel l

Express

e The Find command is accessed via an icon!ili in the lower left section between the Help button and Quick
Launch commands.

e The Last Saved information is now below the thumbnail preview

o A combo box for opening in Full or Express mode is added between the Options... and Quick Launch
buttons. You can open documents in either mode without launching the Options dialog box.

e Inthe File Open Options... dialog box the Full or Express combo button replaces the Open Express checkbox.

File Open Options Lﬁ

Express - ]

I
lag

Design View Representation

[Last Active ~|

Positional Representation

’Master v]

Level of Detail Representation

| Master v

Skip all unresolved files

OK H Cancel ]_




www.irinventor.com D5 s S gl ) a8 (anadd LG54l ka3 Email: irinventor@hotmail.com

Shrinkwrap and BIM Content Enhancements

Shrinkwrap tools have been enhanced for more control, improved user interface, and an improved workflow.
The following are highlights of those improvements:

Access: Shrinkwrap is immediately accessible on the Assembly tab in the Simplification panel.

On first use of Shrinkwrap, for those acquainted with the legacy behavior, you will notice the consolidation of

the dialog boxes. There is a single dialog box with three tabs.

e Components tab - contains the document level information such as representations and the choices you
have for removing components.

e Features tab - contains the choices for easily defining which features to remove from the shrinkwrap part.
You can retain specific feature types, remove them, or remove them by a range value. Additionally there
are tools to help detect and preserve features.

e Create tab - contains the file related information, shrinkwrap style, and other settings.

T D
S ) o . =] [ . ==
Companents | Features | Create Components | Featires | Create ‘ Components | Features | Create |
Representation Remove Features New Fle
) ; ' Part Name Template
Design View: (aogan v LY Remove Holes Remove Pockets S e —
oo — = None None [Shrinkwrap 1} | Standard.pt D)
= % 10 [ () (37 New Fie Location
Level of Detad: Master = 2 5 |2 _
: Max. Diameter € Bounding Box Volume D:\inventor Models\2018 =
Remove Parts
10,000 & 1000000 7143 : Default BOM Structure
Remove parts by size "ﬁl Normal
Remove Fllets Remove Chamfers
) Bounding Box Diagonal < 0.0001 None None Style
Indude Components ::ef; }5’: D "%?%‘ ?: M"“j‘ E”lw
- Max., Radus Mox. Distance 28 |38 06
R | Select to Excude i =
— 10,0001 R 10,0001 Other Settngs
View Selaction
Break ink V| Fill all internal voids
) Induded (277) Parts 57 AFeotores
= (G ] 0o RjLetectestnes Rename components V|Remove internal parts
@) ) Yl 68 o
&j Exduded (3) I§  preserve Features ] Use color override from source component
) Crem) C ) Cam )l (@ ) o) Caa )l | @ ) (o) o

Highlights of the improved workflow:

° Remove components that are invisible and/or within a specified size range and (optionally) interactively
select those you want to keep.

° Remove all part features (hole/pocket/fillet/chamfer) or within a specified size range; and (optionally)
interactively select those you want to keep.

View the component sets to be kept or discarded (Included and Excluded Components), and quickly move
components from one set to the other.

Edit the resulting simplified component using the same workflow you used to create it.

Update the resulting component when the source assembly changes, including non-Inventor models.

Shrinkwrap Substitutes also use this new workflow.
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Related Changes

In Assembly documents, the Simplify tab has been retired and the commands moved to the Simplification
panel. The Simplification panel was formerly the Simplify panel.

Electromechanical Electromechanical Electromechanical
B B cE B B° B & C
Shrinkwrap Shrinkwrap " Shrinkwrap Shrinkwrap Shrinkwrap Shrinkwrap

Substitute Substitute Substitute
Simplification =
€ Simplify View - & Simplify View |~
Define Envelopes % Simplify View
& Create Simplified Part art
|-D:] Simplification | [ @ Edit View |

The Shrinkwrap changes also apply to the LOD New Substitute using Shrinkwrap process.

Inventor to Revit RFA Workflow

The Inventor to Revit RFA workflow incorporates the new Shrinkwrap workflow.
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Drawings

Drawing Open Enhancements
The following changes occur in the lower section of the File Open dialog box.

e The Find command is accessed via an icon!i'li in the lower left section between the Help button and Quick
Launch commands.

e The Last Saved information is now below the thumbnail preview

° A combo box for opening in Full or Defer mode is added between the Options...and Quick Launch buttons.
Defer combines the previous Defer Updates and Fast Open commands into one action causing the drawing
document to open without updating or loading reference documents (parts, assemblies, etc.).

File name: idw -

Files of type: |.Pu_rlodesk Inventor Files (*iam: ™ idw:* dwag: " ipt:"ipn;”ide) - |

Project File: Projects...
Full - | Options... | [ Cpen ] | Cancel

—— ———————

e Inthe File Open Options... dialog box the Full or Defer combo button replaces the Defer Updates and Fast
Open checkboxes.
Drawing View Dialog Box
The Drawing View dialog box has been modestly rearranged to accommodate new options. These are the
changes:
e General
The Preview in the lower left corner is checked by default meaning the preference is to display a preview
rather than a bounding box.
e Display Options tab
o Center Justified - formerly, View Justification, the combo box option is now a checkbox. The box
is checked as a default and keeps the view centered about the placement point. When
unchecked, formerly Fixed, the view will extend or collapse in the direction of the geometry
modification.
o User Work Features - moved to the Recovery Options tab
o The contents of the Display Options tab have been rearranged.
° Recovery Options tab
o Include Mesh bodies - Mesh body support has been extended to drawing views. By default mesh
bodies are not included in drawing views. When placing a view you can include mesh bodies by
checking the option on the Recovery Options tab in the dialog box.
o Include Surface bodies - the option to include surface bodies in drawing views is added to the
Drawing View dialog box. By default surface bodies are not included in drawing views. When
placing a view you can include surface bodies by checking the option on the Recovery Options
tab in the dialog box.
o All Model Dimensions - references all model dimensions in the view. You can remove any
unneeded dimensions.
o Use Work Features - moved from the Display Options tab.
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Workflow Improvements

After selecting an assembly document to place in a drawing, if the preview can display in under 3 seconds it
will do so. If it takes longer a Preview progress dialog box displays. The dialog box is the only element you can
interact with during its display.

If you do not want to wait for the preview, click Cancel to halt the preview process and close the Preview
dialog box. The Preview option is unchecked and the view displays as a bounding box. You can continue to
interact with the entire dialog box, changing documents, representations, view display and so on. To
reactivate a preview, click the checkbox for the preview option.

Drawing support for Mesh Objects

~R7S

Support for displaying and documenting mesh objects is added to drawing views. Mesh objects participate in
all view types and can be annotated. The option to display mesh objects is OFF by default. When placing a
view, go to the Recovery Options tab and specify your view preferences. When working with mesh objects in a
drawing view, you may observe the following:

e Selection mode must be set to Feature Priority to access mesh objects.

e Mesh bodies are kept in browser folders. You control body visibility from the browser node.

e Mesh bodies are visible in Shaded drawing views.
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Text Annotation Enhancement

Add Text Border around Text

You can now add a text border around text and leader text. In the Format Text dialog box, select the drop-
down arrow as shown below, and select Text Border .

-

Note Text (ANST
) WEE Gl - () L)

v| 0120 E'_J B/ IrlullA ol i] 4 00deg )

B > g b~ -
f; |Rear Bxhaust-2 v | | Model Parameters v | |d108 (0.000 deg v| [3.123 »| B A~
A

GENERAL ASSEMBLY NOTE: @

THE ENGINE MAY BE ASSEMBLED
IN 6 STANDARD CONFIGURATIONS

The resulting text is wrapped in a border.

GENERAL ASSEMBLY NOTE:

THE ENGINE MAY BE ASSEMBLED
IN 6 STANDARD CONFIGURATIONS

-100 = REAR EXHAUST 2 SHOE
-200 = REAR EXHAUST 3 SHOE
-300 = REAR EXHAUST 4 SHOE
-400 = SIDE EXHAUST 2 SHOE
-500 = SIDE EXHAUST 3 SHOE
-600 = SIDE EXHAUST 4 SHOE

SEE SHEET 2 FOR PARTS LIST




www.irinventor.com D5 s S gl I3 a8 (anadd LG54l aa e Email: irinventor@hotmail.com

Export to PDF Drawing Enhancement

Export to PDF Options Drawing Enhancements

e The From and To values specified for Sheets in range are no longer session based. The values specified for
Sheets in range now persist across sessions.

e The new option, Display Published File in Viewer, when selected, displays the sheets in Adobe Acrobat
Reader after clicking Save.

PDF Drawing ﬁ

FPrint range Settings
Current sheet | All colors as black
All sheets : | Remove object line weights
@) Sheets in range:
From To Vector resolution:
1 3 400 DPI -

[ Print excluded sheets

[ Display Published File in Viewe

@] m [ Cancel
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Interoperability
AnyCAD and Translator Enhancements

AnyCAD Enhancements (not available in Inventor LT)
Newer Versions of AnyCAD Formats are Supported

You must have Inventor 2017.4 to reference an Inventor 2018 part file in Inventor 2017. Updates can be
downloaded via the Autodesk desktop app or from https://manage.autodesk.com.

Translator Enhancements

CATIA R6 - V5-6R2016 is now supported.

DWG Underlay Enhancements

Insert a DWG File Directly into Your Assembly

You can now import your DWG file directly into an assembly using the Place Components command. In the
Place Component dialog box, you can now choose to include a DWG file as a placed component in your

assembly.

Model ~ Jﬂ@
: A

¥ “rAssembly View v @ [[I ]

B4 Assembly1 4 y

] Relationships
I Representations
I mOrigin E ]

[S GRIPPER_ASSEMBLY.dwg

i ET

Previously, you had to open DWG geometry in an assembly by placing a part file that contained DWG model
geometry.


https://manage.autodesk.com/
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Select Multiple DWG Files When Creating More Than One Underlay

You can now insert multiple DWG files directly into an Inventor assembly or part file to use as an associative
DWG underlay.

When you place or import a DWG file into your part or assembly, any new text style or layer you create now
has the filename as its prefix. For example, if you have a layer named "Layer1" in a DWG file named
"Myfile.dwg," your layer is named "Myfile | Layerl."

New Context Menu Option to Open Part or Assembly in AutoCAD

Now, you can open an AutoCAD DWG file directly from the right-click context menu in your part or assembly
model browser node in Inventor.

To seamlessly open your DWG file in AutoCAD:

e Right click the DWG file node in the model browser.
° Select Open in AutoCAD

|-, Repeat UCS
Add Instance
Delete

Suppress Link
Break Link

|  Open in AutoCAD |

More Context Menu Options Available in Assemblies

After placing an AutoCAD DWG file in your Assembly, the following context menu items are available through
the right-click context menu on your DWG file browser node.

e Delete: Deletes the DWG underlay from the assembly.

e Measure: Measures distances and angles within a view, active sketch, or draft.

e Visibility: Shows or hides the DWG underlay from your assembly file.

e Layer Visibility: Include or exclude layers to show or hide in your assembly.

e Suppress Link: Suppresses or unsuppresses the link to the original DWG file in AutoCAD.
e Break Link: Permanently breaks the link to the original DWG file in AutoCAD.
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DWG Underlay Sketch Geometry Now Automatically Projected
Application Options > Sketch > Autoproject edges during curve creation must be enabled.
If enabled, the following types of DWG geometry are inferred and are automatically projected after sketch

creation:

e Single points, Start/ Mid /End points, Center point of arcs and circle.

e Arcs
e Circles
e Lines

e Polylines A point from a segment of a DWG polyline is inferred and projected. To project the entire
polyline, use Project DWG Geometry.

Cropped DWG geometry is not inferred.
Enhanced DWG Underlay Joint Creation Behavior

Previously when you created a joint on DWG Underlay geometry, the resulting joint was not created on the
same plane as the sketch.

Now if the selected DWG Underlay geometry is within the XY, YZ, or XZ plane, the resulting joint is created on
the same plane as the sketch in the same way a joint is created between 2D Inventor geometry.

Legacy Inventor Inventor 2018
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Collaboration

AnyCAD for Inventor

Reference Future (newer) Versions of Inventor Part and Assembly Files
(not available in Inventor LT)

You can now work with others who are on versions of Inventor that are earlier or later than the version you
are working in. This workflow is called AnyCAD for Inventor.

Starting with Inventor 2017.4, you can reference future (newer) versions of Inventor part and assembly files in
an earlier version of Inventor. For example, with Inventor 2017.4 you can reference an Inventor 2018 part file
in Inventor 2017.

You must have Inventor 2017.4 to reference an Inventor 2018 part file in Inventor 2017. Updates can be
downloaded via the Autodesk desktop app or from https://manage.autodesk.com.

Use the Open, Place, or Derive command to create a reference to a future version of an Inventor part or
assembly file.

Migration: If you open and save the file in a newer version of Inventor (or use Task Scheduler to migrate files
with references to future versions) the future version references are migrated to standard Inventor Place and
Derive relationships.

Presentation Enhancements
(not available in Inventor LT)

Presentation documents now provide more robust support for surface bodies.
You can:

e Use window selection to select multiple surface bodies.
e Use the Tweak command to move surface bodies.
e Use surface geometry to orient and position the Tweak triad.

(7 Axde_Assembly_surface.ipn
v scenel
v [ Axde_Assembly_surface.lam

) Trerimasm: 1
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gmwﬂdrm-u&@wﬂ a° o rad 2 GrlEERaa
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